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1 Introduction 

ColorAdept is a brand-new LED control software committed to creating the 

ultimate user experience. It supports three leading operating systems. Equipped 

with an aesthetic user interface and strong color processing capabilities, it is 

designed to bring an easy-to-use, intelligent, and efficient operation experience for 

users. 

 Cabinet library 

The cabinet library covers the common cabinet types, which is convenient for 

users to select quickly. 

 Color processing 

It is designed to provide three color processing tools Color magic, Curves, and 

3D LUT, which is easy for users to adjust colors quickly and accurately to present 

rich creativity. 

 Frame multiplexing & ShutterLock 

The new virtual shooting methods achieve more creative concepts which 

present in a more realistic way. 

 Multiple processors control 

The parameters of multiple processors can be set simultaneously, which greatly 

improves the user's work efficiency. 

2 Installation 

2.1 Installation for Windows PC 

Step 1 Download the Windows installation file from the official website: 

  https://www.lednets.com/Support/Software/index.html 

Step 2 Open the downloaded file to enter the Setup wizard. 
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Figure 2.1-1 Install now 

Step 3 Select the Install now button or Customize button to continue. 

 

Figure 2.1-2 Install location 

Step 4 When the software has finished installing, click the Start button to launch 

it directly. 

 

Figure 2.1-3 Finish 

2.2 Installation for macOS 

Step 1 Download the macOS installation file from the official website: 

 https://www.lednets.com/Support/Software/index.html 

Step 2 Drag or copy the downloaded file into the application folder to complete 

installation. 
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3 Quick Start 

3.1 Connecting Processors 

Connect processors with a computer through the network cable or ethernet 

switch to the same network segment. 

 

Figure 3.1-1 Multiple processor connection diagram 

3.2 Cabinet Library Configuration 

Step 1 Select an online processor in the Discovered tab of the processor list to 

enter the project management interface. 

 

Figure 3.2-1 Project management 
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Step 2 Select Settings from the function bar to enter the settings interface. 

Step 3 Open the Cabinet Library tab. 

 

Figure 3.2-2 Cabinet library tab 

Step 4 Click the Manage Packs button to enter the cabinet packs interface. 

Step 5 Check whether the cabinet packs meet the requirements. If you need to 

add a new pack, click  to add it. 

 

Figure 3.2-3 Cabinet packs 

3.3 Create New Project 

Step 1 Select the online processor in the Discovered tab of the processor list. 

Step 2 Select the New button in the function bar to enter the new project 

interface. 
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Figure 3.3-1 New project 

Step 3 Set canvas size. 

Step 4 Click the Create button to create a new project and enter the main project 

interface. 

 

Figure 3.3-2 Main project 

3.4 Add Inputs 

The maximum number of inputs depends on the processor type. 

Step 1 Click Layout in the pipeline area. 

Step 2 In the Layout properties area, click Custom in the inputs drop-down box 

or click  to enter the layout mode. 
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Figure 3.4-1 Layout mode 

Step 3 Modify the position or size of the input window in the main view of the 

layout mode. 

3.5 Add Cabinets 

Step 1 Click the Add cabinets button in the toolbar of the canvas view to enter 

the Add cabinets mode. 

 

 

Figure 3.5-1 Add cabinets mode 
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Step 2 Select the type of cabinet that is the same as the actual connected 

cabinets. 

Step 3 Select the appropriate port under the Ports tab. 

Step 4 Click + drag to add cabinets in canvas area, the topology of the cabinet 

is defined by the direction of dragging. 

Step 5 The topology of the newly added cabinets can be modified quickly in 

the Draw Array properties. 

 

Figure 3.5-2 Topology 
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4 Processor List 

The processor list is mainly applied to select the desired processor or processor 

group, which consists of the Discovered and Simulator tabs. 

You can browse the processor information, add or delete processors, add or 

delete processor groups, search for processors, import or export, and perform other 

operations. This chapter takes the Discovered tab as an example. 

 

Figure 4.1-1 Processor list - Discovered tab 

When you select two or more processors, the multiple processors control 

interface will be displayed. 

Note: 

When the group node is selected, all processors in the group are selected by default. 

▪ Refresh : Click this button to refresh the processor display. 

4.1 Processor List 

From top to bottom, it is displayed as all processors, groups, and processors. 
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Figure 4.1-2 Processor list 

The node information are as follows: 

▪ Group: Group name, processors. 

▪ Processor: Type, IP, Project, UID. 

4.2 Toolbar 

From left to right, there are the menu button, add group button, add a 

processor button, and delete button, as shown in the following figure: 

 

Figure 4.2-1 Toolbar 

▪ : Create a group in the processor list. Move any processors requiring 

unified parameter adjustments into the same group. 

▪ : Click to add a processor. 

▪ : Delete the selected processors/groups. 

▪ : Click the menu button to pop up the menu list as shown in the 

following figure: 

 

Figure 4.2-2 Menu list 

 Search: Search for processors under the current tab and support fuzzy 

search of the processor name, type, or IP. 

 Import: Import a configuration file stored on your computer to the 
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processor list. 

 Export: Export the configuration (group and processor information) of the 

processor list to your local disk. 

4.3 Context Menu 

When you select a single processor or multiple processors, the following 

options are displayed. 

Function Description 

Rename Rename the processor. 

Group 
Create a new group and move the processor(s) to the new 

group (for the processor(s) which is/are not in any groups). 

Move to 

group 
Move the processor(s) to the target group. 

Remove 

from group 
Remove the processor(s) from the group. 

Delete Delete the selected processor. 

When you select a single group, the following options are displayed. 

Function Description  

Rename Rename the group. 

Ungroup 
Remove the processor(s) from the group and delete the 

group. 

Delete 

If the group contains at least one processor, selecting 

Delete will delete the group and all processors within it, 

while selecting Ungroup will remove the processors from 

the group and delete the group. 

If the group has no processors, it will be deleted directly. 
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When multiple groups are selected or processors and groups are selected 

simultaneously, the following options are displayed: 

Function  Description 

Ungroup 
Remove the processor(s) from the group and delete the 

group. 

Delete Delete the selected group and all processors in the groups. 

5 Project Management 

Project management is mainly used to create, import, export, and switch 

projects. Projects files are stored in the memory of the processor. 

5.1 History Project 

Prerequisite: An online processor is selected in the processor list and there is 

no project file opened. 

 

Figure 5.1-1 History project 

Function bar 

▪ : Click to enter the new project interface. 

▪ : Click to open the file browser window and import a .capf file stored on 

your computer to the processor. 

▪ : It is available, only when one project file is selected. Click to open the 
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file browse window and select the location to save the file to your computer. 

▪ : Click to enter the settings interface. 

▪ : Click to enter the log interface. 

Project file list 

▪ Project name: It displays the project file name. 

▪ Last used time: It displays the last used time of the project file and clicking 

this heading toggles the project list in ascending/descending order. 

▪ File size: It displays the size of project file. 

▪ Search bar: You can fuzzily search the project name in the project file list. 

When you hover the cursor over a project file, the following three buttons will 

appear. 

▪ : Click to open the project file and then enter the main project interface. 

▪ : Click to rename the project file. 

▪ : Click to delete the project file. 

5.1.1 Open Project 

Three ways can be applied to open a project. 

▪ Method 1: Double-click the project file. 

▪ Method 2: Hover the cursor over a project file and click the Open button 

 among the three buttons displayed. 

▪ Method 3: Right-click on a single project file and select Open in the context 

menu. 

5.1.2 Rename Project 

You can rename a project in two ways. 

▪ Method 1: Hover over a project file and click the Rename button  

among the three buttons displayed. 

▪ Method 2: Right-click a single project file and select Rename from the 

context menu.  
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5.1.3 Delete Project 

There are three ways applicable to delete a project. 

▪ Method 1: Hover over a project file and click the Delete button  among 

the three buttons displayed. 

▪ Method 2: Right-click the project file, select Delete in the context menu and 

you can press Ctrl + click if you need to select more. 

▪ Method 3: Select a project file and delete it by pressing the Delete button 

and you can press Ctrl + click if you need to select more. 

5.2 New Project 

 

Figure 5.2-1 New project 

Create a new project by clicking the New button  on the function bar from 

the History Project interface. Follow these steps to enter the main project interface. 

Step 1: Enter a project name. 

Step 2: Set a suitable canvas size. 

Step 3: Select whether to turn on processor/cable redundancy. 

Step 4: Click Create to enter the main interface of the project. 

Note: 

The project is automatically saved to the memory of the processor. 
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6 Settings 

The settings interface allows you to set the processor parameters, view the 

processor status, manage the cabinet library, set health options, and update the 

processor program. 

Click Settings from the function bar of the history project interface to enter the 

settings interface. If the project is already opened, you can also click Settings from 

the Tools menu in the toolbar. 

 

Figure 6.1-1 History project toolbar 

6.1 Processor Information 

You can view the firmware, hardware, network, and temperature in the 

Processor information tab. 

 

Figure 6.1-2 Processor information 
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6.2 Processor Settings 

 

Figure 6.2-1 Processor settings 

General 

▪ Processor name: It can be customized. 

 

Figure 6.2-2 General 

Network 

The default IP address of the processor is 192.168.1.10, with a subnet mask of 

255.255.255.0. The processor be configured either with a static IP address or an IP 

address allocated by a DHCP server. To ensure proper communication between the 

processor and the computer, each device within the same network should be 

assigned a unique IP address. 

 

Figure 6.2-3 Network 
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Cabinet 

Identify behavior offers two options: 

▪ Front identify & Rear indicators 

▪ Only rear indicators 

 

Figure 6.2-4 Cabinet 

Restore factory settings 

Before restoring the factory settings, users can save the IP address. 

 

Figure 6.2-5 Factory reset 

Note: 

Restore factory settings will delete all project files, imported cabinet packs, other resources 

imported to the processor, and reset the processor settings. 

6.3 Cabinet Library 

To establish normal communication with cabinets and identify their properties, 

the cabinet packs should be placed in the cabinet library for better management. 

Cabinet pack: (.cbp) Compilation of cabinet firmware. Public release will include 

all updated public cabinets to the date of release. 

Cabinet library: A group of cabinet packs installed in a processor. 

Note: 

All processor firmware releases contain the latest cabinet pack at the time of release. 

 

Figure 6.3-1 Cabinet library list 
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Figure 6.3-2 Cabinet pack management 

Cabinet pack list 

The listed packs are sorted by the creation time with the highest priority at the 

top of the list. The priority can be changed by dragging the desired cabinet pack 

above another one which contains the same cabinet type. 

Cabinet pack management 

▪ : Click to add the selected cabinet pack to the processor. 

▪ : Click to delete the selected cabinet pack. 

▪ : Click to export the selected cabinet pack. 

▪ : Move the selected cabinet pack up to raise its priority. 

▪ : Move the selected cabinet pack down to lower its priority. 

▪ : Restore the cabinet library to its default settings. All user-added cabinet 

packs will be deleted. 

▪ : Download cabinet pack from the Cloud. 

Note: 

If a cabinet type exists in multiple cabinet packs, by default the one in the highest priority 

packs is used. 

6.4 Health Settings 

Health settings allow you to select monitoring of video input, cabinet video 

input, cabinet connection status, module wiring, network cable error rate, receiver's 

temperature/humidity/voltage/power supply/fan/dead pixels of a module, and set 

up email notification. 
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Figure 6.4-1 Health settings 

▪ Always display health data 

You can select the checkbox to keep health data visible on the cabinet/module 

with always-on display. 

 

Figure 6.4-2 Always display health data 

▪ Processor video input 

You can choose to enable the processor video input, which allows monitoring 

of the input resolution and frame rate. 

 

Figure 6.4-3 Processor video input 
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▪ Cabinet video input 

You can select the checkbox to monitor cabinet video input. 

 

Figure 6.4-4 Cabinet video input 

▪ Cabinet connection status 

You can select the checkbox to monitor the cabinet connection status. 

 

Figure 6.4-5 Cabinet connection status 

▪ Module wiring 

You can select the checkbox to monitor the module wiring. 

 

Figure 6.4-6 Module wiring 

▪ Network cable error rate 

You can select the checkbox to monitor the network cable error rate. 

 

Figure 6.4-7 Network cable error rate 

▪ Receiver 

You can select the desired checkboxes to monitor the temperature, humidity, 

voltage, power supply, and fan. 

 

Figure 6.4-8 Receiver  
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 Pixel 

You can choose to detect the dead pixels on a module, with three modes 

available. 

 

Figure 6.4-9 Pixel 

 Email settings 

You can choose to receive email alerts and abnormal recovery notifications. 

 

Figure 6.4-10 Email settings 

To configure the email settings, complete the information for the sender and 

the recipient. 

 

Figure 6.4-11 Mail information 

6.5 Update 

Upgrade the processor firmware program. After the update is completed, you 

need to power off and restart the processor. 

 

Figure 6.5-1 Update interface 
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▪ Importing update file 

 Click on the upload area below File to open the file browser window, and 

select the update file. 

 Alternatively, select a local update file, then drag and drop it to the upload 

area. 

Click the Update button to starting upgrading. 

 

Figure 6.5-2 Update 

▪ Update list 

 This list appears only after you enable the Advanced mode and import the 

update file. 

 You can select the checkbox for the board which needs updating. 

7 Main Project Interface 

Creating or opening a project takes you to the main project interface, which has 

three view modes of Canvas, Online, and Health. 

 

Figure 7.1-1 Main interface  
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7.1 Menu Bar 

7.1.1 ColorAdept Menu 

Selecting ColorAdept in the menu bar displays the following options. 

 

Figure 7.1-2 ColorAdept menu 

About ColorAdept 

After clicking ColorAdept, the information of the software is displayed, such as 

the build number, build time, license, copyright, etc. 

Shortcuts (Ctrl + Alt + K) 

Click to open the shortcuts interface of ColorAdept. 

 

Figure 7.1-3 Shortcuts interface 

The shortcuts in the ColorAdept tab are as follows: 
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Figure 7.1-4 ColorAdept tab 

▪ Shortcuts: Ctrl + Alt + K (macOS: ⌘⌥ K) 

▪ Preferences: Ctrl + , (macOS: ⌘,) 

▪ Quit ColorAdept: Ctrl + Q (macOS: ⌘Q) 

 

The shortcuts in the Project tab are as follows: 

 

Figure 7.1-5 Shortcuts in Project tab 

▪ Save as: Ctrl + Shift + S (macOS: ⇧⌘S) 

▪ Save a copy: Ctrl + S (macOS: ⌘S) 

▪ Close: Ctrl + F4 (macOS: ⌘W) 

 

The shortcuts in the Edit tab are as follows: 

 

Figure 7.1-6 Shortcuts in Edit tab 

▪ Undo: Ctrl + Z (macOS: ⌘Z) 

▪ Redo: Ctrl + Y (macOS: ⌘Y) 



ColorAdept User Manual 

24 

▪ Copy: Ctrl + C (macOS: ⌘C) 

▪ Paste: Ctrl + V (macOS: ⌘V) 

▪ Select all: Ctrl + A (macOS: ⌘A) 

▪ Group: Ctrl + G (macOS: ⌘G) 

▪ Ungroup: Ctrl + Shift + G (macOS: ⇧⌘G) 

▪ Delete: Delete (macOS: Delete) 

 

The shortcuts in the View tab are as follows: 

 

Figure 7.1-7 Shortcuts in View tab 

▪ Zoom out: Ctrl + - (macOS: ⌘-) 

▪ Zoom in: Ctrl + + (macOS: ⌘+) 

▪ Zoom 1:1: Ctrl + 0 (macOS: ⌘0) 

▪ Zoom to fit: Ctrl + F (macOS: ⌘F) 

▪ Toggle navigator: Ctrl + Shift + N (macOS: ⇧⌘N) 

▪ Edit: Ctrl + F1 (macOS: ⌘F1) 

▪ Heat map: Ctrl + F3 (macOS: ⌘F3) 

 

The shortcuts in the General tab are as follows: 

 

Figure 7.1-8 Shortcuts in General tab 

▪ End current task: Esc 

▪ Zoom in and out: Ctrl + Wheel (macOS: ⌘Wheel) 
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▪ Pan the view: Space + Drag 

 

The shortcuts in the OSCM - General tab are as follows: 

 

Figure 7.1-9 Shortcuts in OSCM - General tab 

▪ Select horizontal and vertical seams: F1 

▪ Select horizontal seams only: F2 

▪ Select vertical seams only: F3 

▪ Select seams on panel edges: F4 

▪ Select horizontal seams on panel edges: F5 

▪ Select vertical seams on panel edges: F6 

▪ Display white: A 

▪ Display red: S 

▪ Display green: D 

▪ Display blue: F 

▪ Display cyan: G 

▪ Display magenta: H 

▪ Display yellow: J 

▪ Display video: V 

 

The shortcuts in the OSCM - Seam tab are as follows: 

 

Figure 7.1-10 Shortcuts in OSCM - Seam tab 

▪ Luminance: 1 + Left/Right arrow 

▪ Start luminance: 2 + Left/Right arrow 

▪ End luminance: 3 + Left/Right arrow 
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Preferences (Ctrl + ,) 

Click ColorAdept > Preference to open the preferences interface. 

 

Figure 7.1-11 Preferences interface 

 General 

Show Fahrenheit (°F): Tick the box to show temperature in Fahrenheit (℉). If 

unselected, temperature will be displayed in Celsius (℃). 

 

Figure 7.1-12 General 

 Canvas 

 

Figure 7.1-13 Canvas 

▪ Show grid: Tick the box to show grid dots. It is allowed to set the grid 

spacing in the drop-down menu of canvas properties. 
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▪ Snap to grid: Tick the box to pull the cabinets into perfect alignment with 

the grids. 

▪ Snap to cabinets: Tick the box indicates even alignment between every 

cabinet, avoiding overlapping or small gaps. 

▪ Show cabinet index: Tick the box to display the index of each cabinet. 

 Cabinet selection mode 

 

Figure 7.1-14 Cabinet selection mode 

▪ Inside selection area: This option is selected by default. The selection box 

must completely enclose cabinets to select them. 

▪ Overlaps selection areas: Click to select this option. A cabinet can be 

selected if any part of the cabinet is within the selection area. 

▪ Drag direction mode: Click to select this option. Dragging from left to right 

selects cabinets that are completely within the selection box. Dragging from 

right to left to select cabinets at least partially inside the selection area. 

 Advanced mode 

 

Figure 7.1-15 Advanced mode 

Advanced mode: Disabled by default. Once enabled, hidden settings will be 

revealed, including the update list after importing an update file, balance settings 

in HDMI adjustment properties, Ref In multiplier and video delay in network 

properties. In the Failover properties, additional options are displayed, such as 

VSync is not allowed to switch to other input or auto-generated frame rates and the 

behavior option of processor redundancy. 

 Language 

The interface language is allowed to be set as Chinese or English currently. 
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7.1.2 Project Menu 

Selecting Project in the menu bar, and the drop-down menu displays as follows. 

 

Figure 7.1-16 Project menu 

▪ Save as: Save the project to the processor, and the currently opened project 

will be displayed as the saved project. 

▪ Save as a copy: Save the project to your local disk. 

▪ Sync to processor: Sync the project to another processor. 

▪ Close: Close the current project and navigate to the project management 

interface of the current processor. 

7.1.3 Edit Menu 

Click Edit in the menu bar to open a context menu with a list of options as 

follows. 

 

Figure 7.1-17 Edit menu 

▪ Undo: Undo the last action performed. 

▪ Redo: Redo the last action performed. 
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▪ Copy: Copy the cabinets without copying its values in the override 

properties. 

▪ Paste: Paste the cabinets. 

▪ Edit topology: Modify topology connections between added cabinets. 

▪ Clear topology: Clear the topology connections of the selected cabinets. 

▪ Select all: Select all cabinets in the canvas. 

▪ Group: Make a group with the selected cabinets. 

▪ Ungroup: Break the selected groups. 

▪ Delete: Delete the selected cabinets. 

7.1.4 View Menu 

Click View in the menu bar to open a context menu with a list of options as 

follows. 

 

Figure 7.1-18 View menu 

▪ Zoom out: Adjust the view of the canvas to show smaller. 

▪ Zoom in: Adjust the view of the canvas to show larger. 

▪ Zoom 1:1: Adjust the zoom to display the canvas with a 1:1 resolution. 

▪ Zoom to fit: Adjust the zoom and view position to display the full size of 

the canvas in the center of the screen. 

▪ Zoom to selection: Adjust the zoom and view position to fit the selected 

cabinets in the center of the screen. 

▪ Toggle navigator: Show or hide the Navigator window. 

▪ Edit: Edit mode is the default mode of canvas, in which cabinets are 

displayed as viewed from the front. 

▪ Heat map: Display cabinets on the canvas which is colored based on the 

temperature reported by the internal sensors. 
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7.1.5 Tools Menu 

Click Tools in the menu bar to open a context menu with a list of options as 

follows. 

 

Figure 7.1-19 Tools menu 

▪ Settings: Click to open the Settings interface. 

▪ Dynamic color gamut: Click to open the Dynamic color gamut interface. 

▪ OSCM: Click to open the On-screen color management interface. 

▪ Export device layout: Export the cabinet layout of the processor. 

▪ Import device layout: Import the cabinet layout of the processor. 

▪ Print canvas layout: Click to open the Print canvas layout interface. You can 

customize the watermark, table header, and other settings before printing. 

 

Figure 7.1-20 Print interface 
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7.2 Pipeline Area 

The pipeline represents the signal flow of color processing through the 

processor. Each pipeline tile possesses its corresponding properties. Pipeline tile 

properties can be viewed by clicking on a tile to prompt the property editor to 

appear. 

 

Figure 7.2-1 Pipeline 

The pipeline area is composed of INPUTS, PROCESSING, OVERRIDE, and 

OUTPUT. 

 The INPUTS tab contains LAYOUT and ADJUSTMENT tiles. 

▪ LAYOUT: It displays a scaled-down thumbnail of the canvas and layers in 

the layout mode. 

▪ ADJUSTMENT: It displays the selected layer(s) for adjustment. 

 

 The PROCESSING tab includes COLOR MAGIC, CURVES, and 3D LUT tiles. 

▪ COLOR MAGIC: It displays the switch status and the modified colors. 

▪ CURVES: It displays the switch status and the color curve. 

▪ 3D LUT: It displays the switch status and the color intensity. 

 

 The OVERRIDE tab involves PATTERN, FREEZE, and BLACKOUT tiles. 

▪ PATTERN: It displays the switch status and the selected test pattern. 

▪ FREEZE & BLACKOUT: It displays the switch status only. 
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 The OUTPUT tab is comprised of COLOR, NETWORK, and FAILOVER tiles. 

▪ COLOR: It displays the current brightness value, intensity gain, red gain, 

green gain, and blue gain. 

▪ NETWORK: It displays the network bit depth, frame rate, and system load 

of the current processor. 

 Network bit depth: It displays the current output color depth. 

 Frame rate: The displayed frame rate is affected by the settings of Genlock 

and Frame rate multiplication in the property area. 

 System load: It displays the current system load status. Hovering the mouse 

over the load bar reveals the load percentage. 

▪ FAILOVER: It displays the current backup status. 

Enable tile functions by double-clicking the corresponding tiles included in the 

PROCESSING and OVERRIDE tabs. 

Select multiple tiles by Ctrl + click, and the corresponding properties are 

displayed orderly in the property editor from top to bottom. 

7.3 Property Area 

The property area is located on the right side of the main project screen. 

Relevant properties will be displayed based on the user's operations. 

 

Figure 7.3-1 Property area 

The property area can be shown/hidden by clicking the  button. 
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The property area displays the corresponding toolbar buttons according to 

different properties. 

▪ Hide/Show : Hide or show the properties. 

▪ Enable : Click to enable the current properties. 

▪ Reset : Reset the values in the current property area to its default values. 

▪ Pin : Pin and fix the current properties to property area. 

▪ Close : Close current property area. 

7.4 View Area 

7.4.1 Canvas View 

In the canvas view, you can perform operations such as adding/deleting 

cabinets, editing/deleting cabinets topologies, setting canvas properties, 

adding/deleting tiers, and grouping/ungrouping. 

 

Figure 7.4-1 Canvas view 

Canvas toolbar 

▪ Undo : Click to undo the last action performed (A prompt of the action 

is displayed when hovering over the button). 

▪ Redo : Click to redo the last action performed (A prompt of the action 

is displayed when hovering over the button). 

▪ Add cabinets : Click to enter the Add cabinets mode. 

▪ Edit topology : The cursor will turn into a pen after clicking this button. 

 Left-click cabinets to add a topology for cabinets without a topology 

defined. 
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 Right-click a cabinet to clear the topology for the cabinet and cabinets after 

it. 

 Left-click and drag the cabinets without a topology defined, then the 

topology will be applied according to the dragging order. 

 To exit edit topology mode, right-click no-cabinet area. 

▪ Clear topology : Delete the topology of the selected cabinet. 

▪ Zoom out : Adjust view of the canvas to appear smaller. 

▪ Zoom in : Adjust view of the canvas to appear larger. 

▪ Zoom 1:1 : Adjust the zoom to show the canvas with a 1:1 resolution. 

▪ Zoom to fit : Adjust the zoom and view position to display the full size 

of the canvas in the center of the screen. 

▪ Zoom to selection : Adjust the zoom and view position to fit the 

selected cabinets in the center of the screen. 

▪ Toggle navigator : Show or hide the navigator window. 

Canvas edit mode 

Click the  in the upper-right corner of the view area or select the 

corresponding option of the View menu from the menu bar to switch the canvas 

view mode. 

▪ Edit mode: It is the default mode for canvas view, where the cabinets are 

displayed as viewed from the front. 

Canvas properties 

Open the canvas properties by clicking  in the canvas toolbar. 
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Figure 7.4-2 Canvas properties 

▪ Canvas size: Customizable within maximum load limits. 

▪ Background 

 Support to hide or show background. 

 Support importing image file types of JPG, PNG, GIF formats. 

 Support the operation of the imported image for upper-left position 

adjustment, zooming and clearing. 

▪ Grid: Support to modify the color and spacing of grid. 

▪ Canvas edits enabled: You can set whether to allow modification of cabinet 

position in the canvas view. 

Tier properties 

Tiers provide an easy way to manage cabinet overlapping by assigning cabinets 

to tiers with different z-orders which indicates the tier order from top to bottom. 

Open tier properties by clicking  in the canvas toolbar. 
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Figure 7.4-3 Tier properties 

▪ Add: Add a top tier of Z-order. 

▪ Delete: Delete the currently selected tier. 

▪ Show/Hide tiers: Toggle the show/hide status of tiers. 

▪ Rename: Double-click a tier to rename it. 

▪ Tier priority: Drag a tier up or down to adjust its Z-order. 

Library properties 

In the Add cabinets interface, the cabinet properties will be displayed in the 

properties area, which include: 

▪ LIBRARY: Display the cabinet types, resolutions, and maximum frame rates. 

 

Figure 7.4-4 Library properties 

▪ Cabinet information: Right-clicking on a desired cabinet type to access its 

Basic information, Module information, Performance information, Advanced 

information, and other supported features. 
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Figure 7.4-5 Cabinet information 

Array properties 

After adding a cabinet in the Add cabinets interface, the array properties will 

be displayed in the property area, which include: 

▪ Group cabinets: Support adding cabinets in group. 

▪ Topology: Provide eight topologies for quick setup. 

▪ Position: Display the current cabinet position and support adjustment. 

▪ Size: Support adjusting the number of columns and rows when adding 

cabinets. 

▪ Spacing: Support adjusting the horizontal and vertical spacing when 

adding cabinets. 
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Figure 7.4-6 Array properties 

Cabinet properties 

When you click on a cabinet that has not been grouped in the canvas view, the 

properties of the cabinet will be displayed in the properties area which includes the 

information as follows. 

▪ Cabinet information: Display the manufacturer, type, resolution, maximum 

frame rate and group name of the cabinet. 

 

Figure 7.4-7 Cabinet information 

▪ Alignment: Support eight alignment modes for cabinets or cabinet groups, 

which are align left, align horizontal centers, align right, distribute horizontal 

spacing, align top, align vertical centers, align bottom, and distribute vertical 

spacing. 

 

Figure 7.4-8 Alignment 

▪ Topology: Eight cabinet topologies available for quick setup. 

 

Figure 7.4-9 Topology 

▪ Position: It displays the cabinets position, which can be locked to prevent 

editing. 
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Figure 7.4-10 Position 

Overrides properties (Cabinets) 

 

Figure 7.4-11 Overrides 

▪ Override global gains: It means applying independent intensity gain and 

RGB gains for the selected cabinet, regardless of global gain.  
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Device properties 

▪ Device information: It displays the S/N and firmware version of the cabinet. 

 

Figure 7.4-12 Device information 

▪ Enable beacon: It activates the "beacon" test mode of the selected cabinets. 

When the beacon of panel is enabled, the status indicator on the back of the 

panel flashes faster. 

 

Figure 7.4-13 Enable beacon  

Group properties 

When a cabinet group is selected in the canvas view, the cabinet group 

properties are displayed in the properties area. 

▪ Name: It displays the name of the cabinet group and supports modification. 

▪ Color: It displays the color of the cabinet group. Clicking on it will open the 

color selection panel and the selected color will be used as the border color of 

the group. 

 

Figure 7.4-14 Cabinet group 

▪ Alignment: Support eight alignment modes for cabinets or cabinet groups, 

which are align left, align horizontal centers, align right, distribute horizontal 

spacing, align top, align vertical centers, align bottom, and distribute vertical 

spacing. 

 

Figure 7.4-15 Alignment 
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▪ Topology: Eight cabinet topologies available for quick setup. 

 

Figure 7.4-16 Topology 

▪ Position: It displays the cabinets position, which can be locked to prevent 

editing. 

 

Figure 7.4-17 Position 

 Overrides properties (Cabinet groups) 

▪ Override global color: It indicates that you can apply independent 

brightness and color temperature for the selected cabinet groups, regardless of 

global color. 

 

Figure 7.4-18 Override global color 

▪ Override global gains: It means that independent intensity gains and RGB 

gains can be used for the selected cabinet groups, regardless of global gain. 
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Figure 7.4-19 Override global gains 

Context menu 

▪ When you select one cabinet or multiple cabinets, the following options 

are displayed. 

Function Description 

Copy Copy the selected cabinets. 

Paste Paste the cabinets to the current position of cursor. 

Group Make a group of the selected cabinets. 

Ungroup Break the group of current cabinets. 

Add to group Add selected cabinets to the group. 

Remove from 

group 

Remove the selected cabinets from the group (Hold the 

Shift key to select a cabinet within the group). 

Select string 
Select all cabinets connected to the same string as the 

selected cabinet. 

Delete 

topology 
Delete topology of the selected cabinets. 

Select cabinets 

with same type 

Select all cabinets of the same type as the selected 

cabinet. 

Send to back Send to the back of the z-axis of the selected tier. 

Move to tier Move the selected cabinets to a tier. 

Change type... Change the type of the selected cabinets. 

Zoom to 

selection 

Zoom and position the canvas so that the selected 

cabinets are in the center of the canvas view. 
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Delete Delete the selected cabinets. 

▪ When selecting a cabinet group, the following options will appear. 

Function Description  

Copy Copy the selected cabinet group. 

Paste 
Paste the cabinet/cabinet group to the current position 

of cursor. 

Ungroup Break the current cabinet group. 

Select grouped 

cabinets 
Select all cabinets in the current cabinet group. 

Delete 

topology 
Delete topology of the selected cabinet group. 

Send to back Send to the back of the z-axis of the selected tier. 

Move to tier Move the selected cabinet group to a tier. 

Zoom to 

selection 

Zoom and position the canvas so that the selected 

cabinet group is in the center of the canvas view. 

▪ When you click on an area outside the cabinet/cabinet group in the canvas 

view, the following options are displayed. 

Function Description  

Paste Paste the cabinet/cabinet group to the cursor position. 

Zoom to fit 
Adjust zooming and position to show the full view in 

the center of the canvas. 

Zoom to 1:1 
Adjust the zoom to show the canvas with a 1 to 1 

resolution of the display. 

Toggle 

navigator 
Show or hide the navigator window. 

Show group 

name 
Group names can be shown or hidden. 

Group grid Grid dots can be shown or hidden at convenience. 

Snap to grid 

Pull cabinets into perfect alignment with the grid. Is 

enabled by default, helping to align or space cabinets 

evenly on the canvas. 
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Snap to 

cabinets 

Pull cabinets into perfect alignment with other cabinets. 

Is enabled by default to align cabinets evenly on the 

canvas avoiding overlapping or small gaps. 

Canvas edits 

enabled 
Enable or disable modification of the cabinet position. 

7.4.2 Online View 

The online view allows you to view comprehensive information about the 

current processor, the status of all output ports and the details of connected 

cabinets. 

 

Figure 7.4-20 Online view 

▪ Output port list 

It indicates the connection status of output ports. Green (number of cabinets) 

means the port is connected and gray shows unconnected status 

▪ Cabinet list 

It displays information about cabinets, including the output port, string position, 

type, S/N, cable error, temperature, work time, and status. 

▪ Reload firmware: Update the firmware of the selected cabinet. 

▪ Reload parameters: Reload the parameters of the selected cabinet. 

Note: 

When Advanced mode is enabled, "Cable error" will be replaced by "Errors/Total packets". 

7.4.3 Health View 

Health view provides the input status of the video and cabinet temperature, 
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humidity, cable error, voltage, power supply, fan, etc. It also provides monitoring 

reports for users. 

 

Figure 7.4-21 Health view 

Health settings 

▪ Click  in the sidebar to access Health settings. 

Processor video input 

▪ Click  in the sidebar to view the video input, expected and actual 

resolutions and frame rates. 

▪ If the actual resolution and frame rate match the expected value, the actual 

value will be displayed in green; otherwise, it will be displayed in red. 

 

Figure 7.4-22 Health view – Processor video input 

Cabinet video input 

▪ Click  in the sidebar to view the video input, as shown by the legends 

indicating health status (Normal, Error, Invalid, and Offline) at the upper-right 

corner. 
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Figure 7.4-23 Health view - Cabinet video input 

Cabinet connection 

▪ Click  in the sidebar to view the cabinet connection. An error icon  

appears when connection failure occurs. 

 

Figure 7.4-24 Health view - Cabinet connection 

Module wiring 

▪ Click  in the sidebar to examine the module wiring, as shown by the 

legends indicating health status (Normal, Error, Invalid, and Offline) at the 

upper-right corner. 
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Figure7.4-25 Health view - Module wiring 

Cable error 

▪ Click  in the sidebar to view the cabinet cable error, as shown by the 

legends indicating health status (Normal, Warning, Error, and Offline) at the 

upper-right corner. 

▪ The green cabinet indicates that the cable error rate is lower than 

0.95/1,000,000. Orange shows that the cable error rate has reached 

0.95/1,000,000 and red represents that the alarm value of 1/1,000,000 has been 

reached. Gray indicates an offline status of the cabinet. 

 

Figure7.4-26 Health view - Cable error 

Temperature 

▪ Click  in the sidebar to view the cabinet temperature, as shown by the 

legends indicating health status (Normal, Warning, Error, Invalid, and Offline) at 

the upper-right corner. 

▪ The green cabinet indicates that the temperature is 95% lower than alarm 

value. Orange shows that it has reached 95% of the alarm temperature and red 

represents that the temperature alarm value has been reached. Dark gray 

means that the temperature sensor of receiver is invalid or has an incorrect 
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value, and gray indicates an offline status of the cabinet. 

 

Figure7.4-27 Health view - Temperature 

Humidity 

▪ Click  in the sidebar to view the cabinet humidity, as shown by the 

legends indicating health status (Normal, Warning, Error, Invalid, and Offline) at 

the upper-right corner. 

▪ The green cabinet indicates that the humidity is 95% lower than alarm value. 

Orange shows that it has reached 95% of the alarm humidity value and red 

represents that the humidity alarm value has been reached. Dark gray means 

that the humidity sensor of receiver is invalid or has an incorrect value, and gray 

indicates an offline status of the cabinet. 

 

Figure 7.4-28 Health view - Humidity 

Voltage 

▪ Click  in the sidebar to view the cabinet voltage, as shown by the 

legends indicating health status (Normal, Warning, Error, Invalid, and Offline) at 

the upper-right corner. 

▪ The green cabinet indicates that the actual voltage is 95% lower than alarm 
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value. Orange shows that it has reached 95% of the maximum voltage, and red 

represents that the actual voltage has exceeded the alarm voltage value. Dark 

gray means that the voltage of receiver is invalid, and gray indicates an offline 

status of the cabinet. 

 

Figure 7.4-29 Health view - Voltage 

Power supply 

▪ Click  in the sidebar to view the cabinet power supply, as shown by the 

legends indicating health status (Normal, Error, Invalid, and Offline) at the 

upper-right corner. 

 

Figure 7.4-30 Health view - Power supply 

Fan 

▪ Click  in the sidebar to view the cabinet fan, as shown by the legends 

indicating health status (Normal, Error, Invalid, and Offline) at the upper-right 

corner. 
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Figure 7.4-31 Health view - Fan 

Pixel 

▪ Click  in the sidebar to view the detection results of module pixels, as 

shown by the legends indicating health status (Normal, Warning, Error, Invalid, 

and Offline) at the upper-right corner. 

 Pixel detection: Select  from the toolbar to examine dead pixel of the 

current module. 

 

Figure 7.4-32 Health view - Dead pixel detection of module 

Report 

▪ Click  in the sidebar to view exceptions. 

▪ Click  to filter the abnormal data by type. 

▪ Click  to export the currently displayed abnormal data in CSV file 

format. 
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Figure 7.4-33 Health view - Report 

7.5 Auxiliary Area 

The auxiliary area is located at the bottom of the main project screen. 

 

Figure 7.5-1 Auxiliary area 

The auxiliary area contains three tabs of ports, presets, and logs. 

7.5.1 Ports 

The auxiliary area displays the ports tab by default. It is permitted to change 

the cabinet color of ports and view related information. In add cabinets mode, select 

a port first and then add a cabinet to the port. 
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Figure 7.5-2 Auxiliary area - Ports 

▪ The upper right corner of the ports tab displays the total number of used 

cabinets in the canvas / the total number of detected cabinets. 

▪ Each port is corresponding to a module and the information in the module 

is as follows. 

 

Figure 7.5-3 Port info 

 Port index. 

 Port cabinet color (support customization). 

 Total number of cabinets used in the canvas / Total number of detected 

cabinets. 

 Percentage of port load occupied. 

▪ In Add cabinets mode, you can click the port to add the cabinet to the 

corresponding port. 

▪ Context menu 

Function Description 

Port color settings 
Open the color picker and select the desired color 

to apply to the current port. 

Reset current port 

color 
Current port. 

Reset current port 

color 

Reset the cabinet color of the current port to default 

color. 

Apply color to all 

ports 

Apply the cabinet color of the current port to all 

ports. 

Reset all port 

colors 
Reset the cabinet color of all ports to default color. 
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7.5.2 Presets 

Processor parameters can be saved as presets which is convenient to use 

later. 

 

Figure 7.5-4 Auxiliary area - Presets 

▪ Record button : Click to enter add presets mode. 

 

Figure 7.5-5 Add preset mode 

 The record button turns into an exit button . 

 Four icons are displayed next to the exit button, which are color , 

position , video , and dynamic color gamut . Select the 

corresponding icon for the desired preset function, then click the preset tile 

below to save the preset and exit add presets mode automatically. 

 Click the exit button or press ESC to exit add presets mode. 

Preset icon 

▪ Preset color : Include Color Magic, Curves, 3D LUT, global color, 

cabinet/cabinet group color (i.e. override properties). 

▪ Preset position : Record the position of all cabinets in current canvas 

view. 

▪ Preset video : Record the input sources selected in the current output 

area (including the properties, position, viewport area, zoom mode of viewport, 

zooming and aspect ratio of each input source). 

▪ Preset dynamic color gamut : Record the properties of the current 

dynamic color gamut. 
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Preset tile 

 

Figure 7.5-6 Preset tile 

▪ Preset index. 

▪ The status of the preset which displays as a white indicator when enabled. 

▪ Preset name and support customization. 

▪ Preset recorded parameters. If parameters have been recorded, it will 

display an icon in the corresponding position. The first box represents the 

preset color; the second represents preset position; the third represents preset 

video; and the fourth represents preset dynamic color gamut. 

7.5.3 Log 

Click Log in the auxiliary area to be taken to the Log tab. 

 

Figure 7.5-7 Auxiliary area - Log 

▪ You can view and export operational records and errors that occur in the 

current processor. 

8 Inputs 

The inputs in the pipeline area consist of layout and adjustments tiles. 

 

Figure 8.1-1 Inputs 
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8.1 Layout 

8.1.1 Pipeline Tile 

Without any sub-boards, the layout tile appears as follows. 

 

Figure 8.1-2 Pipeline tile 

If there is a sub-board inserted, 

▪ When an input exists in the output area of the layout properties, the layout 

tile is displayed as follows. 

 

Figure 8.1-3 Pipeline tile 

▪ When no input exists in the output area of the layout properties, the layout 

tile is shown as follows. 

 

Figure 8.1-4 Pipeline tile 

8.1.2 Properties 

▪ Currently supported sub-board types: 

 SDIx2; 

 HDMIx2; 

 DPx2; 

 ST2110; 

 3IN1. 

▪ The maximum number of inputs supported is determined by specific 

processor. 
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Cropping 

Cropping feature is used to crop the input sources. 

▪ Cropping checkbox: When disabled, it displays the original size and 

position of the source. 

▪ Dimensions: It is applied to adjust the size and position of cropping area. 

▪ Zoom mode: It is used after the inputs are cropped. It is defaulted as stretch 

mode, you can choose 1:1 mode, fit mode, and fill mode. 

 

Figure 8.1-5 Viewport 

▪ A white dotted box indicates the cropping area. 

 

Figure 8.1-6 Cropping area 
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Zoom mode 

▪ 1:1 mode: The cropped video is at the same size as the original cropped 

image and the top left vertex of the image is aligned with the input source 

window. 

 

Figure 8.1-7 1:1 mode 

▪ Fit mode: Zoom the cropped video to fit the input source window while 

maintaining the aspect ratio. 

 

Figure 8.1-8 Fit mode 

▪ Fill mode: Zoom the cropped video to fill the input source window while 

maintaining the aspect ratio. 
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Figure 8.1-9 Fill mode 

▪ Stretch mode: Stretch the cropped video to fill the input source window 

and match the width and height of the window. 

 

Figure 8.1-10 Stretch mode 

Output area 

 

Figure 8.1-11 Output area 
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There are two ways to set layout mode of input sources. 

▪ Select a quick option in the drop-down box, such as HDMI (1x2). 

▪ Select Custom in the drop-down box or click on  in input source 

window. 

▪ Layout window 

▪ The position and size of the inputs can be modified. 

 

 Layer 

▪ Layer No.: It displays the sequence number of layers. 

▪ Lock/Unlock: Locks/unlock the layer. 

▪ Drop-down list for input sources: Quickly select the input source.  

▪ Zoom size can be set from left, top, width, height. 

▪ Aspect ratio: Set the aspect ratio mode of zooming with free, 4:3, 16:9 

selectable. 

Layout mode 

 

Figure 8.1-12 Layout mode 

▪ Click  to exit layout mode. 

▪ Main view 

 The canvas area is displayed in the center of the main screen. 

 The input source window displays as the monitoring screen. 
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 Support zooming and moving of the main screen. 

▪ When you right-click an input on the main screen, the following menu 

options are displayed. 

Function Description 

Bring to front Bring the layer to the front. 

Send to back Send the layer to the bottom. 

Switch source Switch the selected input source to other sources. 

Lock/Unlock position Toggle the lock/unlock state of the layer. 

Delete Remove layer from the main screen. 

▪ Auxiliary area 

Auxiliary area displays the available input sources, which can be dragged into 

the main screen above. 

8.2 Adjustment 

8.2.1 Pipeline Tile 

▪ When there is no input source in the output area of the layout properties, 

the adjustment tile is displayed as follows. 

 

Figure 8.2-1 Pipeline tile  

▪ When there is at least one input source in the output area of the layout 

properties, the adjustment tile appears as follows: 

 

Figure 8.2-2 Pipeline tile 
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8.2.2 Properties 

Global adjustments 

 

Figure 8.2-3 Global adjustments 

▪ HDR format: It supports SDR, PQ or HLG. 

▪ PQ maxCLL override: Allow the maxCLL value to be specified by the user 

(when ticked) for incoming PQ content. 

▪ PQ gain: A multiplier adjustment to all brightness levels of the incoming PQ 

content. 

▪ PQ auto brighten: Automatically adjusts the brightness of incoming PQ 

content to match the brightness capabilities of the LED panels being used. 

▪ HDR dynamic calibration: It compensates for the loss of brightness before 

and after calibration. 

Color space 

 

Figure 8.2-4 Color space 

▪ Dynamic color gamut button: Click this button to enter the dynamic color 

gamut interface. 

▪ Drop-down box of Color space is used to set color space parameters of the 

input, which is only displayed after dynamic color gamut is enabled. 

▪ Input InfoFrames override color space when present: It indicates that the 
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system is forced to use the color gamut specified by the metadata sent through 

the information frame, which is only displayed after dynamic color gamut is 

enabled. 

Input adjustments 

 

Figure 8.2-5 Input adjustments 

▪ Input selection list: Displays adjustable input sources. 

The following is a display of the corresponding properties of the selected input 

source. 

SDI 

 

Figure 8.2-6 SDI 

Basic information 

▪ Status: The status (includes no signal and signal locked) of the input source 

signal. 

▪ Resolution: The resolution of input. 

▪ Frame rate: The frame rate of input. 

▪ Sampling: Chroma subsampling compression of incoming source. 

▪ Bit depth: The bit depth of the incoming content. 

▪ Format: SDI input format. 

Low latency 
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Figure 8.2-7 Low latency 

▪ Low latency: It reduces the delay time from the input video source, 

processor to the LED display. When low latency is enabled, the input video 

source is preferred to select as the genlock source (when there are multiple 

input video sources, they should be synchronized). 

The following control items can be adjusted by slider or manual entry. 

▪ Black Level: This control affects the base level brightness of darkest content 

of the input. Modifying this value will affect the signal gradually, but it is the 

most pronounced at the lower end of the video signal nearest black. 

▪ Contrast: It controls the difference in brightness between the darkest 

content and brightest content. 

▪ Hue: Adjusts the spectrum of the incoming video feed. 

▪ Saturation: Adjusts the depth of the color. 

 

Figure 8.2-8 Color control 

▪ Red Highlight: It is for adjusting the contrast of red (white level). 

▪ Green Highlight: It is for adjusting the contrast of green (white level). 

▪ Blue Highlight: It is for adjusting the contrast of red or blue (white level). 

▪ Red Shadow: Setting the black level of red for the selected input. 

▪ Green Shadow: Setting the black level of green for the selected input. 

▪ Blue Shadow: Setting the black level of blue for the selected input. 
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Figure 8.2-9 Color control 

Note: 

The RGB highlight and shadow sliders are equivalent to the settings of RGB white level and 

black level respectively. 

HDMI/DP Basic information 

▪ Status: The status (includes no signal and signal locked) of the input source 

signal. 

▪ Resolution: The resolution of input. 

▪ Frame rate: The frame rate of input. 

▪ Sampling: Chroma subsampling compression of incoming source. 

▪ Bit depth: The bit depth of the incoming content. 

▪ HDR status: It shows HDR format, color space, and Max CLL. HDMI/DP is 

displayed as no signal when there is no signal input source. (The following 

information is supported to be expanded/collapsed which is collapsed by 

default.) 

▪ Format: It is used to author the incoming content, which can be SDR or PQ 

or HLG. 
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Figure 8.2-10 HDMI/DP 

The following information is displayed as unspecified when there is no 

HDMI/DP signal. 

▪ Color space: It is the color space used for incoming HDR content. 

▪ Minimum Display Mastering Luminance: The minimum display panel 

luminance for which the HDR content has been authored. 

▪ Maximum Display Mastering Luminance: The maximum display panel 

luminance for which the HDR content has been authored. 

▪ Maximum Content Luminance Level: For incoming HDR content, it displays 

the maximum luminance level that any single pixel is expected to achieve. 

▪ Maximum Frame Average Luminance Level: It displays the maximum 

average luminance level of any single frame for incoming HDR content. 

▪ Red Target: The red point target coordinates to which the incoming HDR 

content that has been authored. 

▪ Green Target: The green point target coordinates to which the incoming 

HDR content that has been authored. 

▪ Blue Target: The blue point target coordinates to which the incoming HDR 

content that has been authored. 

▪ White Target: The white point target coordinates to which the incoming 

HDR content that has been authored. 
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ST2110 Basic Information 

▪ Status: It displays the input status, including no signal and SFP1/SFP2 signal 

locked; 

▪ RJ45: It shows the connection status of RJ45, including unconnected and 

connected; 

▪ Network protocol version: It provides network protocol versions of IPv4 and 

IPv6; 

▪ SFP1: It displays the video stream and audio stream contained in the 

incoming SFP1; 

▪ Video stream IP: It displays the IP address and port number of the video 

stream in SFP1; 

▪ SFP2: It displays the video stream and audio stream contained in incoming 

SFP2; 

▪ Video stream IP: It represents the IP address and port number of the video 

stream in SFP2; 

▪ PTP status: It shows the status of the server, including online and offline 

status; 

▪ Synchronization status: It shows the frame synchronization status between 

different ST2110 sub-boards (cross-processor available), which includes 

synchronized and unsynchronized status; 

▪ Resolution: Resolution of the incoming source signal; 

▪ Frame rate: Frame rate of the content being received from the source; 

▪ Sampling: Chroma subsampling compression of the incoming content; 

▪ Bit depth: Bit depth of the incoming content; 

▪ HDR status: This always shows the HDR format, color space and Max CLL. 

It displays as no signal when ST2110 signal is lost or unconnected (You can 

choose to hide/show the information below, which is hidden by default). 

▪ Format: The HDR format is used to author incoming content. Can be SDR, 

PQ or HLG. 

The information below is displayed as unspecified if there is no signal in ST2110 

port. 

▪ Color space: Color space used for the incoming HDR content. 

▪ Min Display Mastering Luminance: The minimum display panel luminance 

for which the HDR content has been authored. 



ColorAdept User Manual 

67 

▪ Maximum Display Control Brightness: The maximum display panel 

luminance for which the HDR content has been authored. 

▪ Maximum Content Light Level: The maximum light level that any single 

pixel is expected to achieve for the incoming HDR content. 

▪ Maximum Frame Average Light Level: The maximum average light level for 

any single frame of incoming HDR content. 

▪ Red Target: Red target coordinates to which the HDR content that has been 

authored. 

▪ Green Target: Green target coordinates to which the HDR content that has 

been authored. 

▪ Blue target: Blue target coordinates to which the HDR content that has 

been authored. 

▪ White target: White target coordinates to which the HDR content that has 

been authored. 

EDID 

 

Figure 8.2-11 EDID 

▪ Resolution and frame rate of EDID can be customized. 

▪ Bit depth: Support 8bit, 10bit and 12bit. 

Low latency 

 

Figure 8.2-12 Low latency 

▪ Low latency: It reduces the delay time from the input video source, 

processor to the LED display. When low latency is enabled, the input video 
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source is preferred to select as the genlock source (when there are multiple 

input video sources, they should be synchronized). 

Color format 

 

Figure 8.2-13 Color format 

▪ Color format: Support selection from input, RGB, YCbCr4:4:4 or YCbCr4:2:2. 

Quantization range 

 

Figure 8.2-14 Quantization range 

▪ The quantization range setting supports selection from input and limited 

to full. 

The following control items can be adjusted by slider or manual entry. 

▪ Black Level: This control affects the base level brightness of darkest content 

of the input. Modifying this value will affect the signal gradually, but it is the 

most pronounced at the lower end of the video signal nearest black. 

▪ Contrast: It controls the difference in brightness between the darkest 

content and brightest content. 

▪ Hue: Adjusts the spectrum of the incoming video feed. 

▪ Saturation: Adjusts the depth of the color. 

 

Figure 8.2-15 Color control 
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▪ Red Highlight: It is for adjusting the contrast of red (white level). 

▪ Green Highlight: It is for adjusting the contrast of green (white level). 

▪ Blue Highlight: It is for adjusting the contrast of red or blue (white level). 

▪ Red Shadow: Setting the black level of red for the selected input. 

▪ Green Shadow: Setting the black level of green for the selected input. 

▪ Blue Shadow: Setting the black level of blue for the selected input. 

 

Figure 8.2-16 Color control 

▪ Balance settings (HDMI only): This setting is displayed only when advanced 

mode is turned on. 

 

Figure 8.2-17 Balance settings 

9 Color Processing 

The color processing section in the pipeline consists of Color Magic, Curves, 

and 3D LUT. 

 

Figure 9.1-1 Color processing tiles 
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9.1 Color Magic 

Color magic allows you to manipulate single or multiple predefined colors 

without affecting other colors. 

 

Figure 9.1-2 Color magic 

The inner ring is divided into 12 colors and red is selected by default. When the 

cursor is placed on a certain color, the color is convex to indicate it is clickable. 

When you clicked, the color is displayed concave to show that the color has been 

selected. After selecting a color, the H, S, and V values of the color can be set. 

 

Figure 9.1-3 HSV 
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Expand the parameter comparison charts to check the offset of each color 

component more intuitively corresponding to H, S, and V. 

 

Figure 9.1-4 HSV offset 

Black and white are adjusted via RGB gains. 

9.2 Color Curves 

Color curves permit to control the video level of each color channel by creating 

custom transmission curves. 

 

Figure 9.2-1 Color curves 
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Color curves are employed to provide brightness, red, green, blue channel 

curves. After selecting the curve of the desired channel on the bottom of the graph, 

you can select any point on the curve and drag it to the desired position. 

9.3 3D LUT 

3D LUT is an efficient way to map colors and allowed for advanced color 

correction. It is commonly used in film production, from on-set camera adjustments 

to color grading in post-production. 

 

Figure 9.3-1 3D LUT 

Only one 3D LUT file can be loaded into the project once.  

3D LUT strength is controlled by the strength slider. The strength of 0% is 

equivalent to the effect before enabling the 3D LUT and a 100% intensity is 

equivalent to the effect after enabling the 3D LUT. 

10 Override 

The override section in the pipeline area contains three parts of test patterns, 

freeze and blackout. 

 

Figure 10.1-1 Override pipeline tiles 
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10.1 Test Patterns 

To activate test patterns: 

▪ Double-click on the Pattern pipeline tile. 

▪ Click the enable button on the property editor title bar. 

▪ Click the desired test pattern. 

 

Figure 10.1-2 Test pattern 

▪ Speed: This function is applicable when you select four test patterns of 

scrolling grid, scrolling 45° grid, scrolling checkerboard, and scrolling gradient. 

Speed can be adjusted by dragging the slider or clicking spin button, and the 

value range is 1~100. 

▪ Spacing: This function is available when you select four test patterns of grid, 

scrolling grid, 45° grid, scrolling 45° grid. It can be adjusted by dragging the 

slider or clicking spin button, and the value range is 8~1000. 

▪ Gradient stretch: It's usable when you select test patterns of gradient, 

scrolling gradient. It can be adjusted by dragging the slider or clicking spin 

button, and the value range is 1~32. 

 

Figure 10.1-3 Test patterns adjustment 
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Custom color test pattern allows on-screen color display improvement by 

adjusting RGB values only. 

 

Figure 10.1-4 Custom color 

10.2 Freeze 

Enable Freeze to pause the incoming video signal and hold the final frame 

indefinitely until the freeze is disabled. 

 

Figure 10.2-1 Freeze 

10.3 Blackout 

Enable Blackout to make all screens display black and disable the blackout 

function to resume live video. 

 

Figure 10.3-1 Blackout 

11 Output 

11.1 Global Color 

▪ Brightness: Brightness slider allows adjustment for light output on the 

cabinets. Since all cabinet types are calibrated while writing the configuration 

file, the brightness slider is expressed in Nits. This means that arrays with 

different cabinets can be quickly set to the same output level. If you use more 

than one cabinet type with different maximum brightness values, the brightness 

slider defaults to the brightest value that can be reached by all cabinets in the 
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project. 

 Overdrive: Once overdrive has been enabled the slider will allow the 

brightness of the panels to be pushed to the brightness limit of the LEDs within 

the panels.  

 Overwrite: Overwrite the maximum brightness value of the cabinet to 

prevent the cabinet brightness overload. 

▪ Color temperature: It is employed to modify the color of the LED display. It 

allows users to adjust the white balance of attached cabinets in a range of 

2000~11000K. By default, the value is 6504K. 

▪ Gamma: Gamma adjustment is a way to adjust brightness of mid-tones in 

the image without affecting very dark or very bright areas of the image. A 

higher value results in lower brightness overall. 

 

Figure 11.1-1 Global color 

▪ Infi-bit: It is used to improve the low grayscale transition, so that more 

grayscale and low gray information can be displayed on the screen. 

▪ Grayscale refinement: It is applied to eliminate the grayscale jump of the 

screen display, making the grayscale transition smoother. 

▪ Low grayscale optimization: This function is used to optimize the low 

grayscale display effect to make the screen display more delicate. 

 

Figure 11.1-2 Light science 
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▪ Intensity gain: It allows users to modify the brightness of input source. The 

intensity output of all cabinets will change in a linear way. When the intensity 

output is adjusted to 50%, the cabinets will look half as bright to the naked eye 

as they did at 100%. The precise light output of the screen is determined by this 

value in conjunction with the value of the brightness slider. 

▪ RGB gain: It modifies the level of each primary color in the cabinet output. 

Their default value is 100%. Adjusting all 3 RGB gains to 50% has the same 

effect on brightness as lowering the intensity gain to 50%. 

 

Figure 11.1-3 Intensity and RGB gains 

▪ Calibration mode: Both brightness calibration and chroma calibration are 

available. 

 

Figure 11.1-4 Calibration 

▪ Thermal Effects Removal: Tick to remove thermal effects. 

 Panel temperature: Choose From sensor or Custom as you need. 

 

Figure 11.1-5 Thermal effects removal - Panel temperature 

▪ Dynamic color gamut: Click the thumbnail to be taken to the dynamic color 

gamut interface. 
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Figure 11.1-6 Dynamic color gamut 

▪ On-screen color management: Click the thumbnail to enter OSCM mode. 

 

Figure 11.1-7 On-screen color management 

11.2 Network 

▪ Network bit depth: By default, the network bit depth is 10bit, which can be 

changed to 8bit or 12bit. Lowering the network bit depth allows more panels 

to be connected to the processor. 

▪ Additional video delay: It allows the output refresh to be delayed up to 3 

frames, which allows the processor to match the latency present in other display 

systems. Additional video delay is grayed out when Zero latency is enabled. 

▪ Zero latency: Select the checkbox to enable Zero latency. 

Note: 

When Zero latency is enabled, the control area of a single port can only be confined to a 

single layer. The input video source is preferred to select as the genlock source (when there 

are multiple input video sources, they should be synchronized). 

 

Figure 11.2-1 Video 
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Genlock 

 

Figure 11.2-2 Genlock 

▪ Internal: It allows users to customize output frame rate of the processor, 

which ranges from 23.5~251Hz. The processor will automatically compensate 

sources where the source frame rate and the internal refresh rates are different. 

▪ Lock input source: The processor can lock its refresh rate to the input source 

and it will automatically compensate for sources whose frame rate does not 

match the refresh rate of the selected source. 

▪ Ref In: Stand for external synchronous signal. The processor will 

automatically compensate for sources that do not match the external reference 

refresh rate. 

▪ Multiplier: The frame rate of the external Genlock source multiplied by the 

customized multiplication factor acts as the frame rate of Genlock source. It is 

displayed only after enabling advanced mode and it is disabled by default. The 

factor can be set to 2~10. 

▪ Phase Offset: The phase offset permits fine control of LED screen timing to 

rectify visual artifacts displayed on the panel relative to the selected genlock 

source. 

 Angle: This specifies the desired delay as an angle relative to a full circle. 

For example, an angle of 180° corresponds to 1/120th of a second with a 60Hz 

genlock source. 

 Fraction: This is specified as a proportion of the genlock source' frame 

period. For example, with a 60Hz genlock source, a fraction of 50% corresponds 

to 1/120th of a second. 

The output frame rate of the Genlock signal can be calculated by angle or 

fraction settings. These delays can be specified as positive or negative values. Using 
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a negative value, adjust the sync point by adding latency of the input video signal. 

For example, a phase offset of -10% delays incoming video frames by 10% of the 

frame period. 

Frame rate multiplication 

It multiplies the incoming genlock signal. 

▪ Off: Disable multiplication. 

▪ Automatic: If the frame rate of genlock signal ≤ 24.61Hz, it will be 

multiplied by 3 times. Similarly, > 24.61Hz and ≤ 49Hz for 2 times. Except for > 

49Hz, which is not multiplied. 

▪ Specify: The default value is 2 and the value ranges from 2 to 10. 

▪ Frame multiplexing: It allows users to interleave different areas of input 

video raster, solid colors, or image into the output of the LED panel display. At 

its most simple frame multiplexing permits the output frame rate to be doubled 

so that a black frame can be inserted directly into each frame of the actual 

content, which is a useful technique to reduce motion blur. 

 Multiplier: The default value is 2 and the value ranges from 2 to 10. 

 Enable frame multiplexing, and each (up to x10) output frame can be 

configured to display video content, colors or images. 

 Normal/Invert is available for each output subframe. After enabling 

Normal/Invert, you can set the brightness of the subframe. 

 

Figure 11.2-3 Frame rate multiplication 

▪ 3D: Single 3D or Dual 3D modes are available. 
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▪ Single 3D: Set the input source, source format, eye priority and signal delay 

to simulate the actual viewing effect by human eyes. 

 Picture: Your left eye corresponds to the input source layer and right eye 

selects the input source according to the actual situation. 

 Source format: The source format should be set when the left eye and the 

right eye use the same input source. Set the format as left/right or top/bottom 

according to the video source. 

 Eye priority: Set the correspondence between video display and opened 

lens. 

 Signal delay: The delay of transmitted 3D signal compared with the 

processor VSync. 

Note: 

Support single 3D of multiple inputs. After enabled, the total band load is reduced by half. 

▪ Dual 3D: You are able to watch different 3D videos from the same screen 

using different 3D glasses. 

 Glasses: The left eye of Glasses 1 corresponds to the input source layer, and 

the input source of right eye can be selected according to the actual situation. 

The input source of the left and right eyes of Glasses 2 are selected according 

to the actual situation. 

 Eye priority: Set the correspondence between video display and opened 

lens by drag and drop. 

Note: 

Source format and signal delay features are the same as single 3D. There is only one input 

layer for dual 3D. When dual 3D is enabled, the total bandwidth will be reduced by three 

quarters. 
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Figure 11.2-4 Frame rate multiplication 

ShutterLock 

This feature enables the processor to tune the LED panel refresh rate for optimal 

performance to the camera. This helps prevent unsightly artifacts such as scanning 

multiplexed lines and poor exposure, as the camera is not open long enough to 

capture the complete PWM cycle of the LED panel. 

▪ Speed: Manually set shutter speed (1/x) or exposure time. 

▪ Angle: Shutter angle and camera frame rate entry (used to calculate the 

resulting exposure time). 
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Figure 11.2-5 ShutterLock 

Virtual pixel 

Set virtual pixels of the cabinet to let the LED screen deliver a better display 

effect. 

▪ Mode: Select 4x virtual, 3x virtual, or 0.75x virtual as desired. 

▪ Routing: Select Up to down or Left to right. 

▪ Row offset: Choose between None and Upward. 

▪ Column offset: Choose between None and Leftward. 

 

Figure 11.2-6 Virtual pixel 

System load 

Display the processor's system load. The greater the system load, the more the 
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green bar fills. If the processor is overloaded, the green bar will turn red. 

 

Figure 11.2-7 System load 

Video delay 

Display the delayed frame count of online input sources, only when Advanced 

mode is enabled. 

 

Figure 11.2-8 Video delay 

11.3 Failover 

Processor redundancy 

Role (selecting primary/backup means processor redundancy is enabled) 

▪ Off: Processor redundancy is not enabled by default. 

▪ Primary: Indicates that the current processor is the primary processor. 

▪ Backup: Indicates that the current processor is used as a backup. 

VSync is not allowed to switch to other inputs or auto-generated frame rates 

(only shown when advanced mode is enabled). Unticked by default. When ticked 

and an unlocked input is selected as Genlock, it is not allowed to switch to other 

inputs or auto-generated frame rates. 

Behavior 

Only displayed when advanced mode is enabled. 

▪ Always prefer primary if available: The backup processor takes control if the 

output of primary processor fails. The primary processor will automatically 

switch back to take control when the failed output becomes available again. 

▪ Primary only 

 If the current processor is the primary, all port outputs of the primary 
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processor will be enabled. Even if the port failure of primary processor occurs, 

it will not be switched to the backup processor. 

 If the current processor is the backup, all port outputs of the processor will 

be disabled. 

 Select this option to detect whether the current processor has a failed port. 

▪ Backup only 

 If the current processor is the primary, all port outputs of the processor will 

be disabled. 

 If the current processor is the backup, all port outputs of the backup 

processor will be enabled. Even if the port failure of backup processor occurs, 

it will not be switched to the primary processor. 

 Select this option to detect whether the current processor has a failed port. 

 

Figure 11.3-1 Processor redundancy 

Cable redundancy 

It is displayed only when the processor redundancy is turned off and at least 

one option is checked to turn on the cable redundancy. Both fiber port and network 

port redundancy are available. 

Output ports of the processor are listed according to the actual condition and 

these options follow the principle of "even number ports serve as the backup of 

odd number ports". 
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Figure 11.3-2 Cable redundancy 

12 Dynamic Color Gamut 

Dynamic color gamut can be applied to match the actual color gamut and 

target color gamut of display to achieve the ideal display effect. 

There are three ways to enter dynamic color gamut interface: 

▪ Dynamic color gamut button  in the Adjustment property area. 

▪ Dynamic color gamut button  at the bottom of the global color 

property area. 

▪ Dynamic color gamut option  in the Tools menu list. 

 

Figure 12.1-1 Dynamic color gamut interface 

Dynamic color gamut toolbar 

▪ Exit : Exit the dynamic color gamut interface and return to the main 

project interface. 

▪ Undo : Same as the undo button in canvas toolbar. 

▪ Redo : Same as the redo button in canvas toolbar. 

▪ Zoom out : Adjust the horsehoe diagram to appear smaller. 
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▪ Zoom in : Adjust the horsehoe diagram to appear larger. 

▪ Zoom to fit : Zoom to display the full size of the horsehoe diagram in 

the center of the screen. 

▪ Standard color gamut : The standard color gamut which is displayed as 

the corresponding dotted triangle is shown in the horsehoe diagram by default. 

When the following color button is clicked, the screen will display the test 

pattern of that color. Clicking the display video button will disable the test pattern. 

▪ White, red, green, blue, cyan, magenta, yellow. 

Horsehoe diagram 

▪ Video Input color gamut (input source color gamut): It consists of three 

small dots (not linked); if there are multiple input sources, the same specified 

color gamut is used. 

▪ Panel output color gamut (target color gamut): It is comprised of three 

small squares (not linked). 

▪ Display color gamut: It's defined according to the actually selected cabinet, 

as the rainbow area shown below. 

 

Figure 12.1-2 Horsehoe diagram 

Property 

▪ Dynamic color gamut switch: When disabled, the original color gamut of 

the input source is applied directly as the output color gamut. 

▪ Brightness: Same as the brightness in the global color property. 
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Figure 12.1-3 Dynamic color gamut 

Video input color space 

▪ It is allowed to quickly switch to the Rec.2020/DCI-P3/Rec.709 color gamut 

by selecting the drop-down box. The color gamut can be customized by 

modifying the coordinate values of RGBW. 

▪ Input InforFrames override color space when present: It indicates that the 

system is forced to use the gamut specified by metadata sent through the 

information frame. 

 

Figure 12.1-4 Video input color space 

Panel output color space 

▪ When you select a cabinet type from the cabinet type list, the color gamut 

of panel output (consisting of three small squares) is displayed in the color 

gamut horseshoe chart. 

▪ Select drop-down box options: 

 Match input: Use the same color gamut of video input. 

 Achievable: Use the achievable color gamut for the selected cabinet type. 

 Custom: Allow users to define a customized color gamut. 
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Figure 12.1-5 Panel output color space 

The video input color gamut and panel output color gamut can be edited in the 

following three ways. 

▪ When hovering the cursor over the settings box, modify the target value by 

scrolling the mouse wheel. 

▪ Modify target values via keyboard input. 

▪ Modify the input/output target values by dragging the dots/squares in the 

color gamut horseshoe diagram. 

13 OSCM 

OSCM is an abbreviation for On-screen color management. In OSCM mode, the 

brightness of the module or cabinet seams can be adjusted to be consistent with 

the rest of the LED screen. 

OSCM mode can be accessed in the following two ways. 

▪ Click on-screen color management thumbnail located at the bottom of the 

global color property area . 

▪ Select on-screen color management options in the Tools drop-down menu 

. 
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Figure 13.1-1 OSCM 

▪ If the video output is currently in use, putting the processor into OSCM 

mode will disable the video output. 

▪ The OSCM window displays the cabinets as they are positioned on the 

canvas. 

OSCM Toolbar 

▪ Confirm button : After adjusting the seams, click this button to save the 

modifications in OSCM mode and return to the main project interface. 

▪ Cancel button : After adjusting the seams, clicking this button will 

cancel the modification in OSCM mode and return to the main project interface. 

Seam Types 

▪ Select horizontal and vertical seams : Seams of all modules can be 

selected. 

▪ Select horizontal seams only : Horizontal seams of modules can be 

selected only. 

▪ Select vertical seams only : Vertical seams of modules can be selected 

only. 

▪ Select seams on panel edges : All seams of the panel can be selected. 

▪ Select horizontal seams on panel edges : Horizontal seams of the panel 

can be selected only. 

▪ Select vertical seams on panel edges : Vertical seams of the panel can 

be selected only. 
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Cabinet/Module type 

▪ Select module : Adjust color by module. 

▪ Select cabinet : Adjust color by cabinet. 

Note: 

Multiple seams, cabinets, and modules can be selected using Ctrl + click or click + drag the 

left mouse button to create a selection box around the seams. 

 

Figure 13.1-2 Seam types/Color adjustment 

Color 

▪ In OSCM mode, the processor will output a solid color on all connected 

cabinets. White is displayed by default, and red, green, blue, cyan, magenta, 

and yellow are also supported. 

Layer 

▪ You can switch to show or hide the corresponding tier of the display, 

making it easier to select seams in the cabinet or module. 

 

Figure 13.1-3 Color 

Property 

▪ Calibration mode: Multiple calibration modes are available. 

▪ Brightness: It is the same as the brightness in the global color properties. 

 

Figure 13.1-4 Property 
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Seams adjustment 

▪ Brightness: Adjust the overall brightness of the selected seams. 

▪ Start luminance: Adjust the brightness of left part of horizontal seams or 

the top of the vertical seams. 

▪ End luminance: Adjust the brightness of the right part of the selected 

horizontal seams or the bottom of the vertical seams. 

 

Figure 13.1-5 Seam adjustment 

Color adjustment 

▪ RGB gains: Click  or  to access the color adjustment interface to 

increase or decrease the RGB gains of module or cabinet. 

▪ Click  to enable linkage, which allows you to adjust the Red gain, Green 

gain, and Blue gain simultaneously. 

Figure 13.1-6 Color adjustment 

▪ Fine control: Enabling fine controls gives users the finest amount of control. 

 

Figure 13.1-7 Fine control 
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Do any of the following to adjust seam brightness value or RGB gains: 

▪ Press and hold the shortcut key and use either the +/- keys or right/left 

arrows on the keyboard to increase/decrease the luminance. 

▪ Click + drag the wheel to the left/right to increase/decrease the luminance. 

▪ Hover the cursor over the wheel and use the mouse wheel to scroll 

up/down to increase/decrease the luminance. 

14 Multiple Processor Control 

The multiple processors control interface allows freeze, blackout, some 

parameters controlling and preset switching functions for multiple processors at the 

same time. 

How to enter the multiple processors control interface: 

▪ Click on a group with processor included in the processor list. 

▪ Multi-select processors/groups in the processor list via Ctrl/Shift. 

 

Figure 14.1-1 All-in-one control interface 

▪ Every time you enter the multiple processors control interface, all 

parameters in the interface are the values from the opened project of the first 

processor in the processor list. If there are no opened projects in the selected 

processors, all parameters in the interface are displayed as default values and 

grayed out. 

▪ When you change the parameters, only the processor parameters of the 

opened project are modified accordingly. 
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15 Status Bar 

The status bar is located at the bottom of the software interface. 

 

Figure 15.1-1 Status bar 

▪ On the left, there is a prompt for important operations. For example, when 

the cursor is placed in the main view under add cabinets mode, it will display 

as "Click to add cabinet, click + drag to add an array, Escape to finish". 

▪ In the middle of the status bar, it shows the prompt of success/failure of 

operations. 

▪ The right part of status bar exists the prompt of genlock source. 

16 Notification Center 

When there is only one notification, it is displayed in the upper right corner of 

the software by default and can be dragged around. The notification center is used 

to view notifications for all processors or the current processor. 

 

Figure 16.1-1 Notification center 

▪ Switching button: Switch to display the notifications between all processors 

or current processor. 

▪ #: This always shows the number of current notifications and sequence 

number. 

▪ Details: The detailed information of the notifications. 

▪ Correct cabinet type: Click  to automatically correct the mismatched 

cabinet types in the canvas. 

▪ Go to: Click  to go to the relevant interface of the processor. 
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17 Multi-function Card 

Access: Menu bar - Accessories- Multi-function card. 

 

Figure 17.1-1 Accessories - access to multi-function card 

▪ Refresh: Refresh information of the detected multi-function card. 

 

Figure 17.1-2 Accessories - Multi-function card interface 

17.1 Multi-Function Card List 

▪ ＃: Natural number starting from 1. 

▪ Type: Display the type of the multi-function card. 

▪ Version: Display the version of the multi-function card. 

▪ Processor: Display the name of the processor which is connected to the 

multi-function card. 

▪ Port: Display the network port number of the processor which is connected 

to the multi-function card. 
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Figure 17.1-3 Multi-function card list 

17.2 Control Set 

The control set is used to set the processor network ports controlled by the 

multi-function card. 

▪ Add  : Add disassociated processor to the associated processor list. 

▪ Delete  : Remove the selected processor from the associated processor 

list. 

 

Figure 17.2-1 Add disassociated processor 

▪ Associated processor list: Display the name, IP, and number of controlled 

ports/total ports of the associated processor. 

 You can select the processor port you need to control in the list. 

▪ Disassociated processor: A processor that is not controlled by the multi-

function card is displayed in the disassociated processor list. 
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17.3 Sensor Information 

▪ Onboard Sensor: Display temperature and humidity values detected by 

onboard sensor. 

▪ External Sensor: Display information detected by external sensor. 

 Note: 

When at least two sensors are connected to a port via a docking station, "Port X-X" is 

displayed depending on the actual connection. 

  

Figure 17.3-1 Sensor information 

17.4 Power Control 

The power supply is turned on/off by relay in the multi-function card. 

▪ Time: Display the internal time of the multi-function card. 

▪ Read Time: Read the time of the multifunction card and refresh the "Card 

time". 

▪ Sync PC time: Synchronize the time of multi-function card to your PC time. 

▪ Reset: This option shows only when the mouse cursor hovers over this 

power control area. Reset function restores Auto control switch, Auto control 

settings, Timing control switch, Timing control settings, and interval time to 

default values. 
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Figure 17.4-1 Power control 

LED Screen Power Supply 

Relay 1~4 control the on/off of LED screen power supply. 

▪ Close/Open: Click the button to send the corresponding command. The 

relays will be closed/opened by the time interval in sequence. 

▪ Relay status: Green indicator stands for closed status and gray for open. 

 

Figure 17.4-2 LED screen power 
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▪ Auto control switch: Automatic control can be enabled by this switch. 

▪ Auto control settings: It is used to monitor video input, smoke, temperature, 

and will automatically open/close the relay when conditions are met. 

 Relay selection: Select the relay you want. 

 Video input control: It will open the relay when there is no video input and 

close the relay when the video input is restored. 

 Smoke control: The relay will be opened when the smoke value is greater 

than the preset value. 

 Temp control: The on-board sensor temperature or external sensor 

temperature is available. The relays will be opened when the temperature is 

greater than the preset value and remain open when the temperature is less 

than the preset value. 

 

Figure 17.4-3 Auto control settings 

▪ Timing control switch: Automatic control can be enabled by this switch. 

▪ Timing control settings: It allows you to add commands to close or open 

the relay by scheduling. 

 Add command: Add close/open commands and you can specify command 

execution time and effective date. 

 Edit command: Edit the execution time and effective date of close/open 

command. 

 Delete command: Delete the command. 
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Figure 17.4-4 Timing control settings 

▪ Interval: Set the interval for opening or closing the four relays. 

Other Power Supplies 

Relay 5/6/7/8 controls the on/off of remaining power supplies except LED 

screen power supply. 

▪ Rename Button: This button is displayed only when the mouse cursor is 

hovering over the power supply area. 

▪ Auto control switch: Automatic control can be enabled by this switch. 

▪ Auto control settings: It is used to monitor smoke, temperature, and will 

automatically open/close the relay when conditions are met. 

 Relay selection: Select the relay you want. 

 Smoke control: The relay will be opened when the smoke value is greater 

than the preset value. 

 Temp control: The on-board sensor temperature or external sensor 

temperature is available. The relay will be opened/closed when the temperature 

is greater than the preset value. The relay will be opened/closed when the 

temperature is 2℃ lower than the preset value. 

 Sync to relay: You can sync the current settings to the other relays except 

relay 1-4. 
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Figure 17.4-5 Other power supplies-auto control settings 

17.5 Auto Brightness Adjustment 

After enabling auto brightness adjustment, the multi-function card will 

automatically adjust the LED screen brightness according to the ambient 

illuminance captured by the brightness sensor. 

▪ Adjustment mode: There are four adjustment modes.  

  

Figure 17.5-1 Auto brightness adjustment interface 

 Linear mode: Three points on the line are adjustable. 
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Figure 17.5-2 Linear mode 

 Gamma: Two points on the curve are adjustable. 

 

Figure 17.5-3 Gamma mode 

 Inverse-Gamma: Two points on the curve are adjustable. 
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Figure 17.5-4 Inverse-Gamma mode 

 Custom: Nine points on the curve are adjustable. 

 

Figure 17.5-5 Custom mode 

 Reset button: Reset the coordinate of points in the current adjustment 
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mode to default values. 

▪ LED screen brightness: It allows you to set the LED screen brightness, which 

takes effect when an abnormality occurs in the ambient illumination capture. 

 

Figure 17.5-6 Reference value of ambient illumination 
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